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Preface 

This guide clearly and concisely sets out the information developers need to know to get started with 
the CASIO IT-9000 series handheld terminals with the integrated Windows® CE OS development. 
The best methods of connecting to your development system are covered and step by step 
instructions for installing and testing the CASIO BDKs are included. 
 
The purpose of this guide is to get you to the point where you can start development; you should 
refer to the library manuals for detailed information on the specific APIs. 
 
For the IT-9000 series handheld terminals with the integrated Windows Mobile® OS, see the 
IT-9000WM Quick Start Guide available separately. 
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1. Product Overview 

1.1 Features at a Glance 

IT-9000 has been designed using the new concept of the Human-centered Design Processes and is 
capable of performing a wide variety of powerful functions. 
The following is a brief overview of the features available on the IT-9000 series handheld terminals. 
For further detail on the hardware specifications, refer to IT-9000 Series Hardware Manual. 
 
Outstanding development environment  
 Microsoft® Windows® CE 6.0 English Version as the built-in OS 
 Visual Studio 2008 
 Visual Studio 2005 

 
Capability of various communication systems 
 Built-in ultra-small WLAN module compatible with the IEEE802.11b/g standard (IT-9000 

series) 
Built-in ultra-small WLAN module compatible with the IEEE802.11b/g/n standard (IT-9000-B / 
IT-9000-C series) 

 Built-in WWAN module combines GSM, GPRS and EDGE modules with GPS receiver 
designed for use in transportation and logistics. 

 Bluetooth® Version 2.0 
 Serial interface with USB version 1.1 (Host/Client) 

 
Small size, light weight 
 Dimensions : Approx. 111.9(W) x 59.7 (D) x246.3 (H) mm 
 Weight  : Approx. 590 g 

 

Improved durability 
 Impact resistance   : 1.5 m in height * 
 Dust/Water-splash proof : IP54 level (compliant with IEC60529 International Standard) 

 
* The drop durability height is a measured value resulting from actual testing. It does not necessarily guarantee the 

product from damage. 
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Capable of scanning industrial standard bar code symbologies 

1D: 
UPC-A, UPC-E, EAN8(JAN8), EAN13(JAN13), Codabar(NW-7), Code39, Interleaved 2 of 
5(ITF), MSI, Code93, Code128(EAN128(※1)), ISBT, IATA, Code11, RSS-14, RSS Limited, 
RSS Expanded, Code32 
 
2D Stacked: 
Code49, PDF417, MicroPDF, Codablock F, Aztec, QR Code(Model 2), MicroQR, MaxiCode, 
DataMatrix(ECC000/050/080/100/140/200), Composite, TLC39, RSS-14 Stacked, RSS 
Expanded Stacked, CSC 
2D Matrix: 
Aztec, DataMatrix, Maxicode, QR Code, Micro QR, Chinese Sensible Code (HanXin Code) 

 

CPU, Memory 
 High-performance CPU 

Marvell® PXA320 Application Processor (runs at maximum 624 MHz) 

 Large-capacity memory 
RAM : 256 MB 
F-ROM : 256 MB 

 
SIM/SAM 
 ISO7816 IC Card standard 
 3V, 1.8V SIM card supported 
 
Printer 
Method  Dropin-type  Thermal line dot 
Paper width 80 mm or 58 mm 

   Printing width 72 mm (for an 80 mm/82.55mm paper) 
48 mm (for a 58 mm paper) 

Speed 28 lines per second (Max.) 
    Font Size  “x1”, “x1.5”, “x2”, “x3”, and “x4” sizes are supported. 

Font types ANK/Symbologies (UPC-E, NW-7,  Code39, ITF, Code128, OCR-B,   
user-defined characters x 128) 

Dot pitch 0.125mm(8dot/mm) 
Dot size 0.22mm (Length) ×0.125mm(Width) 
 
MCR 
Application card 
 F2F FormatISO7811-2、ISO7811-6） 

The number of the simultaneous uptake trucks 

3Tracks（ISO7811-2、ISO7811-6） 
 
Please refer to a hardware manual for the details. 
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1.2 Library Configuration 

The IT-9000 Software Development Kit (“BDK”) provides various libraries including those listed in 
the table. 
 
Table 1.1 

Library Description C++
VB
C# 

System Library Library that is used to control the system. Yes Yes
Bluetooth Library Library that is used to control the built-in Bluetooth module. Yes Yes
Imager Library Library that is used to control the built-in CMOS Imager. Yes Yes
WANGPRS Library Library that is used to control the built-in WANGPRS module. Yes Yes
JPEG Library Library that is used to handle and manipulate JPEG image 

functions. 
Yes - 

FLINK Library Library that is used to control and carry out transmission/reception 
of files between PC and other device. 

Yes Yes

SAM Library Library that is used to communicate with the SAM Card. Yes Yes
PrinterLibrary Library that is used to control the Printer. Yes Yes
PrinGDI Library Library that is used to control the built-in Printer module in the 

print system 
Yes Yes

MCR Library Library that is used to control the built-in Magnetic Card Reader Yes Yes
NFC Library Library that is used to control to communicate with IC card. Yes Yes
Camera Library Library that is used to control the built-in CAMERA module Yes Yes

Note: 
The abbreviations used in the table are; 

C++  Visual C++ 
VB  Visual Basic .NET 
C#  Visual C# .NET 

 
 
Table 1.2 shows each file name of the Dynamic Link Library and Dynamic Link Class Library. 
 
Table 1.2 

Library Dynamic Link Library Dynamic Link Library 
(Class Library) 

System Library SystemLib.dll SystemLibNet.dll 
Bluetooth Library BluetoothLib.dll BluetoothLibNet.dll 
Imager Library ImagerLib.dll ImagerLibNet.dll 
WANGPRS Library WangprsLib.dll WangprsLibNet.dll 
JPEG Library JpegCe.dll None 
FLINK Library FlinkLib.dll MoFlinkLib.dll 
SAM Library SAMLib.dll SAMLibNet.dll 
Printer Library PrinterLib.dll PrinterLibNet.dll 
PrinGDI Library Cp780Lib.dll Cp780LibVB.dll 

Cp780LibCS.dll 
MCR Library MCReadLib.dll MCReadLibNet.dll 
NFC Library NFCLib.dll NFCLibNet.dll 
Camera Library CameraLib.dll CameraLibNet.dll 
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1.3 Development Manuals 

The IT-9000 Software Development Kit (“BDK”) provides various development reference manuals 
as described in the table below. 
 
Table 1.3 

Development Manual Description 
Quick Start Guide (See note 1) This reference manual. 
Software Manual (See note 1) Reference manual that describes software specifications in detail for all 

the software integrated in IT-9000 handheld terminal. 
Hardware Manual (See note 2) Reference manual that describes hardware specifications in detail on 

each dedicated option and IT-9000 handheld terminal 
System Library Manual Reference manual that describes individual functions in detail for System 

Library. 
Bluetooth Library Manual Reference manual that describes individual functions in detail for 

Bluetooth Library. 
Imager Library Manual Reference manual that describes individual functions in detail for Imager 

Library. 
WANGPRS Library Manual Reference manual that describes individual functions in detail for 

WANGPRS Library. 
JPEG Library Manual Reference manual that describes individual functions in detail for JPEG 

Library. 
FLINK Library Manual Reference manual that describes individual functions in detail for FLINK 

Library. 
SAM Library Manual Reference manual that describes individual functions in detail for SAM 

Library. 
PrinterLibrary Manual Reference manual that describes individual functions in detail for Printer 

Library. 
PrinGDI Library Manual Reference manual that describes individual functions in detail for 

PrinGDI Library 
MCR Library Manual Reference manual that describes individual functions in detail for MCR 

Library 
NFC Library Manual Reference manual that describes individual functions in detail for NFC 

Library 
Camera Library Manual Reference manual that describes individual functions in detail for 

Camera Library 
 
Notes: 
1. The dedicated quick start guide for models with the integrated Windows CE OS. 
2. The hardware reference manual for models with the integrated Windows CE OS or with the 

Windows Mobile OS. 
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2. Prerequisites 

2.1 Skills Required 

IT-9000 application can be developed by the following languages. 
- Visual C++ (Native or Manage code) 
- Visual Basic .NET 
- Visual C# .NET 
- Browser based applications (not covered in this guide) 

The application developed by C/C++ languages runs at high speed under the operation of the native 
environment. On the other hand, the application developed by C++/CLI,VB.NET and/or C# 
languages runs slower due to the Manage code. 
The following skills or experience are also desirable. 

 Windows CE devices 
 ActiveSync 
 Some networking experience 
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2.2 Hardware Required 

The following models of the IT-9000 series and dedicated options are available. 
 
Table 2.1  List of available models 

Model no. Printer 
C-MOS
Imager

MCR 
W-WAN

GPS 
W-LAN 

(802.11 b/g)
Camera NFC 

Extnsion
Slot 

IT-9000-E Yes - - -  Yes - Yes - 
IT-9000-GE Yes - - Yes Yes - Yes - 
IT-9000-GMC30E Yes Yes Yes Yes Yes Yes Yes - 
IT-9000-20E Yes Yes - - Yes - Yes - 
IT-9000-G20E Yes Yes Yes Yes Yes - Yes - 
IT-9000-GM30E Yes Yes - Yes Yes - Yes - 
IT-9000-E-B Yes - - -  Yes - Yes  
IT-9000-GE-B Yes - - Yes Yes - Yes  
IT-9000-GM30E-B Yes Yes - Yes Yes - Yes  
IT-9000-G20E-B Yes Yes Yes Yes Yes - Yes  
IT-9000-GMC30E 
-B 

Yes Yes Yes Yes Yes Yes Yes  

IT-9000-E-C Yes - - -  Yes - Yes - 
IT-9000-GE-C Yes - - Yes Yes - Yes - 
IT-9000-G20E-C Yes Yes Yes Yes Yes - Yes - 
IT-9000-GM30E-C Yes Yes - Yes Yes - Yes - 
IT-9000-GMC30E 
-C 

Yes Yes Yes Yes Yes Yes Yes - 

"-C" attached at the end of model number in Tables 2.1 differs from other models. Refer to "9. 
Differences". 
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Table 2.2  List of the dedicated options 

Option Product Model no. Remark 
USB Cradle HA-L60IO 

HA-L60IO-CN 
 
 

Cradle 
Ethernet Cradle HA-L62IO 

HA-L62IO-CN 
 
 

Battery  
Battery Pack HA-G20BAT  

 
Dual Battery 
Charger 

HA-G32DCHG  

Cradle-type Battery 
Charger 

HA-L30CHG  
HA-L30CHG-CN  

 
Battery charger 

Car Mounted-type 
Battery Charger 

HA-H35CHG 
 

With  Car  power  Cable 
 

AC adaptor 
(for HA-L60IO, HA-L62IO, 
HA-L30CHG,) 

AD-S42120C-N5 
AD-S42120B-N 
AD-S42120BE-CN 

Without power cable accompanied 
 
 

USB cable DT-380USB-A To connect cradle to PC 
USB cable 
(Host) 

HA-L80USBH 
HA-L80USBH-CN 

 

USB cable 
(Client) 

HA-L81USBH 
HA-L81USBH-CN 

 Cable 

USB-Serial cable HA-L82RSC 
HA-L82RSC-CN 

 

AC-CORD-EU for Europe 
AC-CORD-US for USA/Canada 
AC-CORD-TW for Taiwan 
AC-CORD-KR for Korea 

Power Cable (for AD-S42120) 

AC-CORD-AU for Australia/New Zealand 
* The AD-S42120B-N is not sold in the EU or in EFTA member states. 
 
Note: 
“-CN” attached at the end of model number in Tables 2.1 and 2.2 denotes that the model is dedicated 
for the final destination of China. A note about compliance with the Chinese “RoHS” requirement 
promulgated by the Ministerial Decree No. 39 is included in the carton box; the RoHS compliant 
seal is affixed on the body and the seal of the packing material recycle marking is affixed on the 
carton box. 
See the following pages for IT-9000 terminal external views and the dedicated options. 



 

 13

 
External views of IT-9000 and the dedicated options 
 

 

 

Figure 2.1 
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2.3 Software Required 

PC Operating System 
 Microsoft Windows XP Professional Service Pack 2 or later 
 Or Microsoft Windows 2003 Server Service Pack 1 or later 
 Or Microsoft Windows Vista (Business / Ultimate ) 
 Or Microsoft Windows 7 
 Or Microsoft Windows Server 2008 

 
Development platform 
Figure 2.3 

Programming 
Language 

Development Platform 

Visual C++ 
Visual Basic .NET 
Visual C# 

Microsoft Visual Studio 2005 + SP1 or later 
Microsoft Visual Studio 2008 + SP1 or later 

 
Communication software  

The software to be used depends on Windows XP, Windows Vista or later OS. 
 

 For Windows Vista or later OS 
Microsoft Windows Mobile Device Center 6.1 (32 bits) for Windows Vista  
Download for free; 
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-0
9F07AAA1914&displaylang=en 

 
 Windows XP, Windows Server 2003 

Microsoft ActiveSync 4.5 
Download for free from: 
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-D
C09F8141141&displaylang=en 

 
 
CASIO IT-9000 BDK 

Download the IT-9000 BDK from: 
http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by CASIO.) 

 

http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC09F8141141&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC09F8141141&displaylang=en�
http://www2.casio.co.jp/system_en/pa/PADealer/�
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3. Installing BDK to PC 

3.1 Application Development 

This chapter explains about what you need to set up for the development environment before 
starting your application development. 
 
1. Installing Development Platform 

Install Microsoft’s development platform which supports Visual Studio 2008 and Visual Studio 
2005. For detail, refer to Chapter 2.3 “Software Required”. 

 
2. Installing CASIO BDK to PC 

Install Casio’s BDK (“Basic Development Kit”) and various libraries if necessary. For 
installation method, refer to Chapter 3.2 “Installing CASIO BDK Files”. 

 
3. Connecting IT-9000 to PC (via either ActiveSync or Windows Mobile Device Center) 

Connect IT-9000 to PC via Microsoft’s ActiveSync (for Windows XP or Windows Server 2003) 
or via Windows Mobile Device Center (for Windows Vista or later). For connection method, 
refer to Chapter 5 “Connecting IT-9000 to PC”. 

 
4. Setting up the Development Environment 

Transmit the Casio’s libraries to IT-9000. 
For detail, refer to Chapter 6 “Setting Up the Development Environment”. 

 
5. Installing the Device Emulator 

Install the Device Emulator for IT-9000. For installation method, refer to Chapter 7 “Device 
Emulator”. If not necessary to install, go to “6. Application Development” below. 

 
6. Application Development 

Now, the application development environment is set up and your development with the 
development platform can be started. After application is developed, transfer it to the Device 
Emulator or an actual terminal of IT-9000 via ActiveSync or Windows Mobile Device Center for 
check on the operability. For application development method and transferring your application, 
refer to Chapter 8 “Visual Studio”. 
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3.2 Installing CASIO BDK Files 

Download the CASIO IT-9000 BDK installation CD image file from the following site and write it 
to a CD-ROM media. 
http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by CASIO.) 

 
Notes: 

 If your PC runs in the Windows Vista or later OS, first you must disable the User Account 
Control (“UAC”) by following the process below before installing the CASIO BDK Files. 

 
  Case of using Windows Vista and Windows Server 2008 

- Navigate to Control Panel → User Accounts → Enable or Disable the User 
Account Control. Remove the check on User Account Control (UAC) to protect 
your PC, and then click OK button. 

 
  Case of using Windows 7 

- Navigate to Control Panel → User Accounts → Change User Account Control 
Settings.  Select Never notify in Choose when to be notified about changed to your 
computer setting. 

http://www2.casio.co.jp/system_en/pa/PADealer/�
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Installing ExportBDK 

1. When the CASIO IT-9000 BDK CD-ROM is inserted in the drive of PC, the following menu 
screen appears automatically. 

 

Figure 3.1   Version number in the figure may differ from that of your CD. 
 
2. Click Installation List in Figure 3.1. The installation screen appears. 

  
Figure 3.2   Version number in the figure may differ from that of your CD. 
 
3. Click the IT-9000 ExportSDK to display the Setup Wizard.  

Choose any one of the buttons in the screen. 



 

 18

 

Installation Steps 

① Starting the Setup Wizard 
 The startup of the Setup Wizard display is appeared 

         

 
Figure 3.3 

 
        Click the [Next (N) >] button. 
 
        (2) Confirming Software License Agreement 
        Be sure to carefully read and understand the Software License Agreement in the screen and confirm the 

terms of the agreement. 
 

 
        Figure 3.4 
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        (3) Accepting the Software Licensing agreement 
        After you accept the Software License Agreement terms, tick the [A (Accept)] button. 
         

 
Figure 3.5 
 

        Click the [Next (N)>] button. 
 
        (4) Entering Customer Information 
         Enter your customer name and organization. 
 
        Click the [Next(N) >] button. 
 

     
Figure 3.6 
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     (5) Choosing Setup type 
    
        Choose either [Custom (U)] or [Complete (O)] button as a Setup type. 
        Choosing [Custom (U)] allows you to freely select components to set up and only the necessary 

components can be set up into your PC. If choosing is not required, Choose [Complete (O)] button 
and set up all the components. 

 

 
Figure 3.7 

 
        Select [Custom (U)] or [Complete (O)] button.       
     

(6) Destination Folders 
 
Confirming the destination folders is possible in this step. 

 

 
Figure 3.8 

 
       If you wish to change the destination folder, click the [Change (C)…] button to install to a different 

folder. 
       Click the [Next]>] box. 
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        (7) Ready to install 
        

          
Figure 3.9 

 
         Click the [Install (I)] button to begin the installation. 
 
         (8) Processing the installation 

        When the installation begins, the processing status is indicated in the screen. 
 

 
Figure 3.10 
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 (9) Completing the Setup Wizard 
 

When the Setup is completed, the Setup completing screen will appear. 
 

 
Figure 3.11 

 
Click the [Finish (F)] button to exit the Setup Wizard. 
 
Up to this step, the preparation to use IT-9000 ExportSDK is completed. 
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3.3  Installing Library 

The IT-9000 Library is available for the below development platforms. 
 

 Microsoft Visual Studio 2008 
 Microsoft Visual Studio 2005 

 
Notes: 
1. The Library header file (*.h) and the Import library file (*.lib) are installed in the following 

folder. 
C:\Program Files\CASIO\MBSYS\include : Header file 
C:\Program Files\CASIO\MBSYS\lib\ARMV4I : Import library file 

2. The Class library DLL file (*.dll) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\WindowsCE 

3. When the Library is installed in PC, the Help file (*.chm) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\HELP 
 

The Help file can be accessed by navigating to Start menu  All Programs  CASIO Basic 
Development Kit  Help. 

 
 

Installing Online Help 

Besides the Help file described above, the Online Help is also available for the below development 
platforms. The installation of the Online Help is initiated in the Installation List. 
 

 Microsoft Visual Studio 2008 
 Microsoft Visual Studio 2005 

 
After the installation is complete, Microsoft Visual Studio starts up. The Online Help file can be 
accessed by navigating to Help → Contents menu. 
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3.4 Installing Online Help 

Besides the Help file described in the previous page, the Online Help is also available for the below 
development platforms. The installation of the Online Help is initiated in the Installation List. 
 

 Microsoft Visual Studio 2008 
 Microsoft Visual Studio 2005 
 
After the installation is complete, Microsoft Visual Studio starts up. The Online Help file can be 
accessed by navigating to Help → Contents menu. 
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4. Connecting Power Supply to Cradle 

4.1 HA-L60IO 

Use the dedicated AC adaptor (AD-S42120B) for supplying power to the HA-L60IO USB Cradle. 
Ensure that you connect the AC adaptor to the cradle before starting communication between 
IT-9000 and PC via the cradle. Follow the steps below to connect the power supply to IT-9000 using 
the dedicated AC adaptor. 
 

 
Figure 4.1 
 
4. Plug the AC adaptor into the AC adaptor jack where "DCIN12V" is printed on the back of the 

cradle. 
 

5. After connecting the power cable to the AC adaptor, plug in the plug to an electrical outlet. 
 

6. Make sure the selector switch on the back of the cradle is set to position B. 

7.  

A：Using as USB Host.  

B：Using as USB Client. 

 

※Only the USB device which Casio verified 

is supported. 
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Connect a USB cable (DT-380USB) to the USB client port on the back of the cradle, and then 
connect the other end of the cable to the PC. USB host port is used when connecting the cradle 
with other USB peripheral devices. 

 
8. Align the USB cradle mount holes on the back of IT-9000 with the mount hooks on the cradle 

after aligning the power/signal contacts on the bottom of IT-9000 with the power/signal contacts 
of the cradle. The power LED on the front of the cradle will light green if IT-9000 has been 
properly mounted. 
 
Status of Indicator 1 on IT-9000 

Orange : Charging 
Red : Standby due to battery pack error or the surrounding temperature is out of the range (charging 

begins when the temperature returns within the correct range.) 
Green : Charging complete 

 
Notes: 

 Always remove IT-9000 from the cradle when switching the selector switch on the cradle. 
 Never short the power/signal contacts of the cradle. This damages the cradle. 
 Do not subject IT-9000 and cradle to vibration or impact during communication. This results in 

communication being interrupted. 

 When mounting IT-9000, securely attach it to the mount hooks of the cradle and check that the 
power LED on the front of the cradle lights green. Charging the battery pack or communication 
will not proceed if it is not mounted properly. 
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4.2 HA-L62IO 

Use the dedicated AC adaptor (AD-S42120B) for supplying power to the HA-L62IO Ethernet 
Cradle. Ensure that you connect the AC adaptor to the cradle before starting communication 
between IT-9000 and PC via the cradle. Follow the steps below to connect the power supply to 
IT-9000 using the dedicated AC adaptor. 
 

 
Figure 4.2 
 
1. Plug the AC adaptor into the AC adaptor jack on the back of the Ethernet Cradle. 

 
2. After connecting the AC adaptor to the power cable, plug in the plug of the power cable to an 

electrical outlet. 
 

3. Set the selector switch on the back of the Ethernet cradle to the port that will be used. Set the 
switch to "LAN" to use the LAN port or to "USB" to use the USB port. 

  

Figure 4.3

LAN：Connect to LAN. 

A：Using as USB Host.  

B：Using as USB Client. 

 

※Only the USB device which Casio verified 

is supported. 
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4. Before using the cradle ports, remove the caps from the ports. When using a LAN, connect one 

end of the LAN cable to the LAN port and the other end to the PC or hub. When using a USB 
connection, connect one end of the USB cable (DT-380USB) to the USB port and the other end 
to the PC. 

 
5. Align the power/signal contacts on the underside of IT-9000 with the power/signal contacts on 

the Ethernet Cradle and then set IT-9000 into the cradle so that mount holes in the back of 
IT-9000 are aligned with the mount hooks on the cradle. Once IT-9000 is properly set in the 
cradle, the power LED on the front of the Ethernet cradle lights green. 
 
Status of Indicator 1 on IT-9000 

Orange  Charging 
Red  Standby due to battery pack error or the surrounding temperature is out of range 

(charging begins when the temperature is within the correct range.) 
Green  Charging complete 

 
Notes: 

 Always remove IT-9000 from the Ethernet Cradle before changing the selector switch setting. 
 Never short out the power/signal contacts of the cradle. This damages the cradle. 
 Do not subject the IT-9000 and cradle to vibration or impact during communication. This results 

in communication being interrupted. 

 When mounting IT-9000, securely attach it to the mount hooks of the cradle and check that the 
power LED on the front of the cradle lights green. Charging battery pack or communication will 
not proceed if it is not mounted properly. 

 The LAN and USB connections cannot be used concurrently. 
 Always cap ports that are not being used. Using the Ethernet Cradle while the ports are 

uncapped can cause damage. 
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5. Connecting IT-9000 to PC 

To make connection establishment with PC, use one of the methods, depending on the OS your PC 
runs, described below. 
 

 ActiveSync (for Windows XP, WindowsServer 2003, or any other OS earlier installable) 
Use the ActiveSync to connect IT-9000 to PC if the PC runs in Windows XP or other OS earlier 
than Windows XP. The ActiveSync can be downloaded at the URL below. 
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC0
9F8141141&displaylang=en 

 

 Windows Mobile Device Center (for Windows 7,Windows Vista, Windows Server 2008, or OS 
later installable) 
Use the Windows Mobile Device Center to connect IT-9000 to PC if the PC runs in Windows 
OS. The Windows Mobile Device Center (“WMDC”) can be downloaded at the URL below. 
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F
07AAA1914&displaylang=en 

 
  [For WS2008] 

   Before installing Windows Mobile Device Center, you need to make the Desktop Experience 
feature on Windows 2008 active. For further details, refer to the following web site. 

 
Web site: 
http://support.microsoft.com/kb/950169/en-us 

http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC09F8141141&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC09F8141141&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
http://support.microsoft.com/kb/950169/en-us�
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5.1 ActiveSync Connection via USB 

If you have already installed ActiveSync and connected IT-9000 to the PC via direct USB, You may 
skip Chapter 5.1.1. You already have the USB driver and ActiveSync in your development 
environment. If you do not yet have the cradle driver on your PC, download the USB driver files 
“wceusbsh.inf” and “wceusbsh.sys” from the CASIO web site and copy them to an appropriate 
folder. 
 

5.1.1 Installing ActiveSync for the First Time 

1. Install ActiveSync first. Run the ActiveSync ‘msi’ file. 

 

Figure 5.1 
 

2. Click Install button. 

 

Figure 5.2 
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3. Pause the installation when the menu in Figure 5.3 is displayed; you have to install the driver at 

this point. 

 
Figure 5.3 

 
4. Connect the USB cable to the PC and the other end to the USB Cradle and also the AC adaptor to 

the USB Cradle. 
5. Put IT-9000 on the cradle and confirm that the green LED on the front of the cradle is lit. If not, 

be sure IT-9000 is positioned firmly on the cradle. 
6. When IT-9000 is mounted on the USB Cradle, a dialog is displayed to prompt you to install the 

suitable driver. If you have not yet obtained the driver files, see page 16 for detail of what you 
need to download. 

7. Choose No, not this time radio button in Figure 5.4 and then click Next > button. 

 

Figure 5.4 
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8. Then, choose Install from a list or specific location [Advanced] radio button in the menu. 

 

Figure 5.5 
 

9. Click Next > button. 

 

Figure 5.6 
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10. Choose Windows CE USB Devices icon. 

 

Figure 5.7 
 

11. Click Have Disk… button. 

  

Figure 5.8 
 

12. Click Browse… button. Select “wceusbsh.inf” from the folder you created in step 6. 

 

Figure 5.9 
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13. The installation of the driver will start. 

 

Figure 5.10 
 

14. Click Continue Anyway button. 

 
Figure 5.11 

 
15. A menu might be displayed to prompt you to install “wceusbsh.sys”. This happens if 

“wceusbsh.sys” is not in the same folder as “wceusbsh.inf”. Download this file from the CASIO 
Web Site and follow the prompts to specify the location of “wceusbsh.sys”. 
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16. Now the installation of the driver is finished. 

 

Figure 5.12 
 

17. Now go back to the ActiveSync Installation Wizard that you left on the desktop. Click Next > 
button. 

 
Figure 5.13 



 

 36

 
18. Now the connection is established. You can choose either partnership option according to your 

needs. Then click Next > button. 

 

Figure 5.14 
 

19. Now the connection is completed. You can start up Visual Studio and create a program and 
deploy it to IT-9000. 

 

Figure 5.15 
 
 

Caution 
- When you turn the USB interface switch on/off, be sure to remove IT-9000 from the Cradle. 
- Make sure not to short the feeding terminals. Shorting circuit of the terminals may cause the 

defect. 
- Don’t give any vibration or mechanical shock to the USB interface during communication. If 

you do so, it may cause communication malfunction. 
- When you set IT-9000 on the Cradle, be sure to securely set it to the fixing hooks on the cradle 

and check the power indicator LED on the front of the cradle lights on. Improper setting may 
cause malfunction of communication and/or may not charge the battery. 
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5.1.2 If ActiveSync Is Already Installed 

This is the procedure if ActiveSync is already installed on the PC. You just need to let the PC 
recognize IT-9000 and install the cradle driver as in steps 6 to 16 in Chapter 5.1.1. 
 
1. Navigate to File → Connection Settings…. from the menu in ActiveSync. See Figure 5.16. 

 

Figure 5.16 
 

2. Exclude a check Allow USB connection with this desktop computer.  

 

Figure 5.17 
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3. On IT-9000, in Control Panel, choose the PC Connection option. Confirm that PC 

Connection is set to “USB Default”. If not, choose ‘USB Default’ and tap OK button. 

 
Figure 5.18 

 
4. When IT-9000 is mounted on the USB Cradle, a menu to prompt to install the driver is displayed. 

Follow the same steps in Chapter 5.1.1. 

 

Figure 5.19 
 

  After driver installation is completed, 
 - Check "Allow USB connections" in ActiveSync. (See Figure 5.17) 
 - Dismount the device from the cradle and mount the device on the cradle again. 

 

Caution 
- When you turn the USB interface switch on/off, be sure to remove IT-9000 from the Cradle. 
- Make sure not to shirt the feeding terminals. Shirting circuit of the terminals may cause the 

defect. 
- Don’t give any vibration or mechanical shock to the USB interface during communication. If 

you do so, it may cause communication malfunction. 
- When you set IT-9000 on the Cradle, be sure to securely set it to the fixing hooks on the cradle 

and check the power indicator LED on the front of the cradle lights on. Improper setting may 
cause malfunction of communication and/or may not charge the battery. 
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5.2 Windows Mobile Device Center via USB 

To establish connection via USB interface with PC runs in Windows 7, use Windows Mobile Device 
Center ("WMDC"). The IT-9000 is setting to ActiveSync/WMDC by default. 
 
 
Follow the steps below: 
1. Install WMDC to the PC, if not installed. 
2. Connect the USB cable to the PC and the other end to the USB Cradle and also the AC adaptor to 

the USB Cradle. 
3. Make sure the selector switch on the back of the cradle is set to position B. 
4. Put IT-9000 on the cradle and confirm that the green LED on the front of the cradle is lit. If not, 

be sure IT-9000 is positioned firmly on the cradle. 
5. . Follow a message appeared in the WMDC on the PC.  
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5.3 Connection via WLAN 

To establish communication between IT-9000 with the WLAN module integrated (see Table 2.1 for 
the applicable models) and PC via WLAN configuration, follow the steps, 1 to 6, below to set up a 
WLAN configuration on IT-9000. After setting up the configuration, be sure to perform a site 
survey prior to starting communication via WLAN. 
 

1. Navigate to Start  Settings  Ctrol Panel  WLANConfig and then click IP tab. 

 
Figure 5.20 

 
Table 5.1 

Parameter Description 
Enable DHCP or Configure IP Determines “Enable” or “Disable” for DHCP. 
IP Determines IP address. 
MASK Determines subnet mask. 
GateWay Determines default gateway. 
DNS1 Determines primary DNS address. 
DNS2 Determines secondary DNS address. 
WINS1 Determines primary WINS address. 
WINS2 Determines secondary WINS address. 

 
If any of the settings in Figure 5.20 is omitted, the process described in the following table will 
automatically take place in the field. 
 
Table 5.2 

Parameter Nothing is set (DHCP) “Configure IP” is set 
Enable DHCP or 
Configure IP 

“Enable DHCP” is assumed. “Configure IP” is set. 

IP Does not determine IP address. Entered address is set as is. 
MASK Does not determine subnet mask. Entered address is set as is. 
GateWay Does not determine gateway. Entered address is set as is. 
DNS1 Does not determine primary DNS address. Entered address is set as is. 
DNS2 Does not determine secondary DNS address. Entered address is set as is. 
WINS1 Does not determine primary WINS address. Entered address is set as is. 
WINS2 Does not determine secondary WINS 

address. 
Entered address is set as is. 
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2. Click Basic tab. Set up each parameter in the tab by referring to the descriptions for the 

parameters in Table 5.3. 

 
Figure 5.21 

 
Table 5.3 

Parameter Description 
SSID Enter the SSID of the network you want to connect to. 

Disable None. 
WEP Open in Authentication field. 

Security 

WPA PSK in Authentication field (if selected, the Key field must be set also.) 
EAP-PEAP in Authentication field 
EAP-TLS in Authentication field 

Key Enter 26 (maximum) alphanumeric digits (13 hex pairs) in the Key field if 128 bit 
radio button is selected. Or, enter 10 (maximum) alphanumeric digits (5 hex pairs) in 
the Key field if 64 bit radio button is selected. 
 
The field displays the number of characters that have been entered. 
***** in the field implies that the key has been extracted from the ini file. If ***** in 
the field is edited, a new key has been deemed to be set. Or, if it has never been edited, 
the key extracted from the ini file becomes effective as is. 

 
If EAP-PEAP radio button in Authentication field is selected, click the EAP-Properties button 
that appears when selecting the EAP-PEAP radio button to set also the following parameters. 
Table 5.4 

Parameters in 
EAP-Properties screen 

Description Default 

User name Input a user name in alphanumeric (maximum 100 
alphanumeric). 

None 

Password Input a password in alphanumeric (maximum 100 
alphanumeric). 
 
***** in the field implies that the password has been 
extracted from the ini file. If ***** in the field is 
edited, a new password has been deemed to be set. 
Or, if it has never been edited, the password extracted 
from the ini file becomes effective as is. 

None 

Domain Input a domain in alphanumeric (maximum 100 
alphanumeric). 

None 

Validate server 
certificate 

 Set up the requisition for server certificate. 
With check mark   : certificate is required. 
Without check mark: certificate is not required. 

Certificate is not necessary
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If EAP-TLS radio button in Authentication field is selected, click the EAP-Properties button that 
appears when selecting the EAP-TLS radio button to set the following settings. 
 
Table 5.5 

Parameters in 
EAP-Properties screen 

Description Default 

User name Input a user name in alphanumeric (maximum 100 
alphanumeric). 

None 

Certificate Select a client certificate installed already (maximum 
100 alphanumeric). 
 
Search button in the field will display a list of 
installed client certificates. Select one by highlighting 
it. 

None 

Domain Input in alphanumeric (maximum 100 alphanumeric) None 
Validate server 
certificate 

Set up the requisition for server certificate. 
With check mark   : certificate is required. 
Without check mark : certificate is not required. 

Certificate is required. 

 
3. Click WLAN tab. 

 
Figure 5.22 

 
Table 5.6 

Field / Radio 
Buttons 

Description Default 

On Enable power to the integrated WLAN module. Yes Adapter power 
Off Disable power to the integrated WLAN module.  
Enable Enable power save mode for the WLAN module. Yes Power save 
Disable Disable power save mode for the WLAN module.  
b Set up IEEE802.11b standard effect.  Standard 
b/g Set up IEEE802.11b/g standard effect. Yes 
No roaming Set up “-100 dBm” for roaming starting threshold level, 

a level where communication via WLAN is practically 
impossible, so that roaming should not be carried out.   

 

Default Set up “-78 dBm” for the roaming starting threshold 
level. 

Yes 

RSSI Level for 
initiating roaming 

High Set up “-72 dBm” for roaming starting threshold level, 
for faster (more frequent) roaming 
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4. Click Detail tab. 

  
Figure 5.23 

 
Table 5.7 

Field / Radio Buttons Description Default 
WLANConfig, 
NetSearch 

- Use only CASIO provided WLAN tool. 
- Configure WLAN setting with settings 

extracted from the ini file. 
- Initiate NetSearch when tapping the icon in 

the task tray. 

Yes 
 

WLANConfig,  
NetUI 

- Use both CASIO provided WLAN tool and 
MS tool. 

- Configure WLAN setting with settings 
extracted from the ini file. 

- Initiate NetUI (MS tool) when tapping the 
icon in the task tray.  

 

WLAN configure,  
Status display tool 

NetUI/NetUI - Use only the MS tool. 
- Configure WLAN setting, not with settings 

extracted from the ini file. 
- Initiate NetUI when tapping the icon in the 

task tray. 
 
If this radio button is selected and the OK button 
that appears in the subsequent popup warning 
message is clicked, other settings in the ini file 
will be deleted. Only the WLAN configuration 
set with NetUI is saved.  

 

With check mark : enable the setting.  Enable AdHoc network setting 
Without check mark : disable the setting. Yes 
With check mark : enable the setting.  Enable all authentication settings 
Without check mark : disable the setting.  Yes 

Inifile comment Enter a comment of up to 100 characters to be 
written in the ini file. 

None 
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5. If OK button in the popup warning message (see Table 5.7 for description of NetUI/NetUI radio 

button) is clicked, the screen in Figure 5.24 appears. Click OK button to perform a reset on the 
terminal so that the setting takes effect. 

 
Figure 5.24 

 
6. Check to make sure that the connection has been established using the NetSearch utility, and 

then navigating to the Ping function in there. Enter HostName first and then click Ping to check 
that you are connected to the network correctly. 
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5.4 Connection via Ethernet Cradle 

This chapter describes how to establish a high speed LAN connection with the cradle (HA-L62IO). 
 
Follow the steps below: 
1. Connect the dedicated AC adapter to the cradle in the steps described in [Cradle HA-L62IO 

Connection]. 
2. Connect one end of the network cable to the Ethernet cradle and the other end to the network hub. 
3. Make sure the selector switch on the back of the HA-L62IO Ethernet cradle is set to the position 

“LAN”.  

4. Place IT-9000 in the cradle and navigate to Start  Settings  Control Panel  Network 
and Dial-up Connections. 

5. The following screen appears. Double click the AX887721 icon. The icon will not appear unless 
the terminal is placed in the cradle. 

 
Figure 5.25 
 
6. The following TCP/IP screen appears. Set up all the parameters in IP Address and Name 

Servers tabs as required and click OK button. 

 
Figure 5.26 

 
7. If the connection is established correctly, the icon ( ) in the Taskbar changes to ( ). 
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5.5 Accessing Shared Network Drive on Your LAN 

Assuming you have a valid network connection established, you can access shared drives on your 
PC from the File Explorer on IT-9000. The following shows the steps to initiate this. 
 
1. Configure a network connection on IT-9000. 
2. Double click My Computer. 
3. Type \\xxxx\ where xxxx is the network name of the PC. 
4. A network logon dialog box will appear. Enter a valid User ID, Password and Network 

Domain. 
5. Any shared network drives on the target PC will be displayed and you will be able to copy files 

freely between them and IT-9000. 
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5.6 Direct TCP/IP Connection from Visual Studio 

If you have a network connection to IT-9000 (for example, via WLAN or the Ethernet cradle) then 
you can establish a direct link to the development PC without using ActiveSync. 
 
For Visual Studio 2005 
1. Download the files listed below to IT-9000. 

- Clientshutdown.exe 
- ConmanClient2.exe 
- CMAccept.exe 
- DeviceDMA.dll 
- eDbgTL.dll 
- TcpConnectionA.dll 

 
The source folder in the PC: 

C:\Program Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\armv4i 
The destination folder in IT-9000: 

\Windows 
 
2. Run ConmanClient2.exe on IT-9000. 
3. Set the device IP address in Visual Studio 2005.  

4. Navigate to Tools in the main menu of Visual Studio 2005  Options…  Device Tools 
 Devices.  

5. Choose IT-9000 Device in the pull-down menu of Devices: and click Properties…. 
6. Click Transport: to access Configure… and set up Device IP address as shown in Figure 

5.27. 

 

Figure 5.27 
 

7. Run CMAccept.exe on IT-9000. 

8. Navigate to Tools in the main menu of Visual Studio 2005  Connect to Device…. 
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9. Choose IT-9000 Device in the list of Devices: and click Connect button. The screen in 

Figure 5.28 if appear indicates the success of connection establishment. 

 
Figure 5.28 
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6. Setting Up the Development Environment 

6.1 Installing CAB Files 

1. After installing the library files, the CAB files in Table 6.1 will be installed in the folder 
below. 

C:\Program Files\CASIO\MBSYS\CAB 
 

Table 6.1 
Library CAB file Preinstalled 

System Library en_SystemLib.ARMV4I.CAB Yes 
Bluetooth Library en_BluetoothLib.ARMV4I.CAB Yes 
Imager Library en_ImagerLib.ARMV4I.CAB Yes 
WANGPRS Library en_WANGPRSLib.ARMV4I.CAB No 
JPEG library enJPEG.ARMV4I.CAB Yes 
FLINK library en_Flink.ARMV4I.CAB Yes (note 2) 
SAM Library en_SAMLib.ARMV4I.CAB Yes 
Printer Library en_PrinterLib.ARMV4I.CAB Yes 
PrinGDI Library en_PrinGDILib.ARMV4I.CAB 

en_PrinGDILibWM.ARMV4I.CAB 
Yes 

MCR Library en_MCReadLib.ARMV4I.CAB 
en_MCReadLibWM.ARMV4I.CAB 

Yes 

NFC Library en_NFCLib.ARMV4I.CAB 
en_NFCLibWM.ARMV4I.CAB 

Yes 

Camera Library en_CameraLib.ARMV4I.CAB 
en_CameraLibWM.ARMV4I.CAB 

Yes 

Notes: 
1. The library with "Yes" in "Preinstalled" column is preinstalled in IT-9000 and in the Device 

Emulator. Thus, it is not necessary to install it, unless it has been updated or changed. 
2. The CAB file, en_Flink.ARMV4I.CAB, in the table does not operate for IT-9000. Use the 

FlinkLib.dll installed by default in the terminal. 
 

2. Copy all the CAB files in Table 6.1 to any folder on IT-9000 via ActiveSync. 
3. Carry out each CAB file. 
4. When the installation starts, the installation status will appear. 
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6.2 Visual Studio 2005 

The procedures for remote-debug using IT-9000 in the development of VB.NET and/or C# 
application are described in this section.  
 
Follow the steps in Chapter 5  “Connecting IT-9000 to PC” before checking the steps below to 
confirm that you can connect to IT-9000 from Visual Studio 2005. 
 
1. Establish connection with the IT-9000 via ActiveSync. 
2. Open the application project for VB.NET or C# in Visual Studio 2005. 
3. Click the button shown in the red box below (see Figure 6.1) to make sure that Visual Studio 

2005 has recognized the connection established with the IT-9000 via ActiveSync. If it does not, 
start up ActiveSync again to establish connection. 

 
Figure 6.1 

 
4. Choose IT-9000 Device in the pull-down menu box. 

 

Figure 6.2 
 

5. You will now be able to deploy solutions and also debug applications on the attached IT-9000 
using the Visual Studio 2005 debugging features. 
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7. Device Emulator 

The Device Emulator provides application developers with an environment that, without having 
the actual terminal available, allows them to debug basic functions and performance of an 
application at source level by stepping through the code. 
 

7.1 Software Required 

The Device Emulator requires the software(s) listed below before installing the emulator. 
 ActiveSync 4.5 or a later version (If required) 

http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC0
9F8141141&displaylang=en 

 Visual Studio 2008 or Visual Studio 2005 (Required) 
 CASIO IT-9000 BDK (Required) 
 Standalone Device Emulator 3.0 (Optional. See notes 1 and 2.) 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4
b2f-a394-356e2c2fb114 

 
Notes: 

To use Microsoft Device Emulator 3.0, follow the steps below. 

 Install the IT-9000 ExportSDK and Device Emulator of the IT-9000 BDK. 
 Download Microsoft Device Emulator 3.0 and install it. 
 Edit the following file and save the changes made. 

C:\Program Files\Windows CE Tools\wce600\IT-9000\Emulation\IT-9000 QVGA.cdes 
C:\Program Files\Windows CE Tools\wce600\IT-9000\Emulation\IT-9000 VGA.cdes 
 

 
Before you change, the default parameter in the file is described as follows. 

[Emulator] 

module=DevEmu500.exe 

 
Change the parameter to the one below. Be sure to describe the whole parameter in single 
one line. 

[Emulator] 
module=C:\Program Files\Microsoft Device Emulator\1.0\DeviceEmulator.exe 

 
You can substitute the Device Emulator Version 3.0 released in Visual Studio 2008 for an 
engine of Device Emulator included in IT-9000 BDK by the mentioned procedure above. 

 

http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC09F8141141&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC09F8141141&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
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Case of using after Windows Vista OS 

If you use OS after Windows Vista (Windows 7 or Windows Server 2008), please set device 
emulation and I/O simulator as administrator. 
Please check “Run this program as an administrator” of property from opening Explorer. 
(Ex. Execute I/O simulator in Windows Vista as administrator.) 
 

 
Figure 7.1 

 
These program have installed the following location as default setting. 

 Device emulator 
C:\Program Files\Microsoft Device Emulator\1.0\DeviceEmulator.exe 

 I/O simulator 
C:\Program Files\Common Files\CASIO\Emulator\DevIoSim.exe 
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7.2 Starting Up the Device Emulator 

After installing all required software described in Chapter 7.1, follow the steps below to start up the 
Device Emulator on your PC. 
 

1. Navigate to Start menu  All Programs  CASIO Device Emulator and click IT-9000. 
2. Make sure that the IT-9000 Device Emulator has started up on the screen. See Figure 7.2. 

3. Navigate to Start menu  All Programs  CASIO Device IO Simulator and click IO 
Simulator. 

4. Make sure that the IO Simulator has started up on the screen. See Figure 7.3. 
5. If both Figure 7.2 and Figure 7.3 appear on your PC, you are ready to use the emulator. 

 
Note.  
If do not appear "IT-9000" in "CASIO Device Emulator", please execute "Add Device". 
If you use OS after Windows Vista, please execute "DevEmuLoader.exe" as administrator by 
referring " Case of using after Windows Vista OS" section. 

 
 C:\Program Files\Common Files\CASIO\Emulator\DevEmuLoader.exe 

 

 
Figure 7.2  IT-9000 Device Emulator Figure 7.3  I/O Simulator 

 
 
Terminology of Emulator and Simulator; 
The Emulator described in this reference manual is a software application that behaves in a very 
similar way to the actual device by imitating individual hardware components or protocols present in 
the actual hardware.  
On the other hand, the Simulator is also a software application that logically integrates application 
programming interfaces (“API”) and certain other functions to allow debugging of the application 
program using external events. The Emulator performs in a pseudo CPU and hardware 
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environment and it is impossible for the application to recognize whether it is in the actual device 
environment or pseudo environment. However, actions carried out by the Simulator are not as 
alike to those performed by actual components but merely mimic them very closely. 
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7.3 Using the Device Emulator 

7.3.1 IT-9000 Device Emulator 

The IT-9000 Device Emulator emulates various operations carried out by the actual IT-9000 
device on the PC’s screen such as mouse operation, input on PC’s keyboard, displaying execution of 
applications, and operations by actual devices such as the scanner. Figure 7.4 shows an emulated 
IT-9000 device on the screen of a PC. 

 
Figure 7.4 
 

Key Input 
The emulator offers key input capability similar to that of the actual IT-9000 device. For instance, a 
key on the emulated keyboard of IT-9000 on the screen (see Figure 7.4) can be clicked with the PC 
mouse as well as key input made directly on the PC’s keyboard. 
 

Reading Bar Codes 
The emulator enables bar codes pre-registered in the I/O Simulator (see Figure 7.3) to be input when 
clicking Trigger key on the emulated keyboard (see Figure 7.4). Note however that the Trigger key 
must be continuously pressed for a second or more otherwise an incorrect key input may result. 
 

Sound 
The emulator offers beep and sound capability similar to that of the actual IT-9000 device. 
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7.3.2 I/O Simulator 

The I/O Simulator simulates registration of bar codes, generation of low battery warning, detection 
of terminal being mounted on the cradle.  

 
Registration of bar code symbologies 
1. Registration 

Click ADD1D or ADD2D button (circled in red in Figure 7.4) to go into the bar code 
registration mode. 

 

Figure 7.5 
 

2. Bar code registration 
Choose a bar code symbology in the Code Type pull-down menu that you wish to register in 
the I/O Simulator. 

 

Figure 7.6 
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3. Registration of bar code and note 

Enter bar code data in the Code field (see Figure 7.7) and a note about the bar code in the 
Note field if necessary. Click OK button to complete the bar code registration. 

 
Figure 7.7 
 

4. Completion of registration 
After completion of the bar codes registration, the screen in Figure 7.8 shows a list of bar codes 
that have been registered in the I/O Simulator. Prior to debugging with the Device 
Emulator, make sure that you register all bar codes you wish to use in debugging. 

 

Figure 7.8 
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5. Editing registered bar code content 

Highlight a bar code in the list of registered bar codes (see Figure 7.8) and click Edit button. 
Figure 7.9 appears for editing the bar code and its information.  

 
Figure 7.9 
 

6. Deleting registered bar code content 
Highlight a bar code in the list of registered bar codes (see Figure 7.8) and click the Del button. 
Dialogue screen in Figure 7.10 appears for you to confirm the deletion. If it is okay to delete, 
click Yes button, otherwise click No button. 

 

Figure 7.10 
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7. Barcode Reader 

By selecting a registered barcode,it can be read into the emulator 
 
Select any barcode and then click the emulator trigger key 
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Detection of Terminal in Cradle and Low Battery Warning 
If you check the box and Low Battery boxes in STATE SETTING field (see Figure 7.11), the 
simulator simulates the respective events in the emulator.  

 
Figure 7.11 
 

I/O Box 
If this box is checked, a notification is issued that the connection between the IT-9000 Device 
Emulator and cradle has been established. This notification can be utilized by the application.   
 

Low Battery 
If this box is checked, a notification that a low battery state has occurred is raised. The icon in the 
Toolbar in the emulated screen appears too. The notification can be utilized by the application to 
recognize the low battery state in the hardware. 
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Indications 

The I/O Simulator expresses a change of state that occurred in the IT-9000 Device Emulator. 
 

LED 

When the IT-9000 Device Emulator turns on the LED, the LED icon (LED2) in the I/O Simulator also turns 
on. See Figure 7.11. 
 

Vibration 

When the IT-9000 Device Emulator vibrates, the vibration icon in the I/O Simulator also turns on. See 
Figure 7.11. 
 

 

Figure 7.12 
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7.3.3 Connecting via ActiveSync 

If debugging with the Device Emulator is carried out in Visual Studio 2008 or Visual Studio 2005, 
or transmission/reception of a file with the Device Emulator is carried out, ActiveSync must be 
used. 
 

Setting ActiveSync 
1. Start up ActiveSync and then navigate to File  Connection Settings …. 

 
Figure 7.13 
 

2. In Connection Settings screen, check in the Allow connections to one of the following 
box and choose DMA in the pull-down menu. See Figure 7.14. 

 

Figure 7.14 
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Connection via ActiveSync 
The way to establish connection of the Device Emulator via ActiveSync is; 
 
3. Start up the Device Emulator by referring to Chapter 7.2 “Starting Up the Device Emulator”. 

4. Start up Visual Studio 2008 or Visual Studio 2005, and then navigate to Tools  Device 
Emulator Manager. Right-click the IT-9000 Emulator in Available Emulators list and 
then choose Cradle in the popup menu. See Figure 7.15. 

 
Figure 7.15 
 

5. Make sure ActiveSync has started up and the  icon in the status bar appears. See the emulated 
screen of IT-9000 in Figure 7.16. The icon indicates that the connection via ActiveSync has been 
established. 
 

 

 

 

Figure 7.16 Figure 7.17 
 



 

 64

 

7.4 Debugging Applications 

This chapter describes how to debug your application using the Device Emulator. Before starting 
to “Build”, establish a connection between IT-9000 and your PC via ActiveSync by referring to 
Chapter 7.3 “Using the Device Emulator”. 
For the basic order of developing an application, refer to Chapter 8 “Visual Studio”. 
 

Setting Build Configuration 

Choose Debug in the Solution Configurations pull-down menu in Visual Studio 2008 or Visual 
Studio 2005 and the IT-9000 Emulator in the target device pull-down menu. See Figure 7.18. 

 

Figure 7.18 
 

Debugging Applications 

 Basic Debug Operation 
The debug operation used for the Device Emulator in Visual Studio 2008 or Visual Studio 
2005 is the same as an ordinary debug operation using the actual terminal. 

 

 Debugging with the Device Emulator 
With the Device Emulator, it is possible to set a break point in the source code of the 
application for step-by-step debugging. 

 

1. Navigate to Debug menu  Start Debugging to start up the debugger. 

 
Figure 7.19 
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2. Similar to ordinary debugging operations with an actual IT-9000, the Device Emulator 

allows break point setting (circled in red in Figure 7.20) in the source code and step-by-step 
debugging. 

 
Figure 7.20 

   
Note: If the Device Emulator does not allows break point setting in the source code step-by-step, 

install Microsoft .NET Compact Framework 2.0 SP2 into your PC. 
 
      .NET Compact Framework 2.0 Service Pack 2 --- Redistributable package 

Microsoft .NET Compact Framework 2.0 SP2 can be downloaded from the following site: 
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=17981 

http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=17981�
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8. Visual Studio 

This chapter describes application development steps in Visual Studio 2008 or Visual Studio 2005 to 
create an example program. The example program referred to in this chapter is an application 
program developed in three development environments - Visual Basic.NET / C# / C++ - using the 
CASIO Common Device Control Library or Common Device Control Class Library. The example 
program for all three environments repeats turning on and off the LED to brink for a period of 5 
seconds. See Chapters 8.1 “Developing in C++”, 8.2 “Developing in VB.NET” and 8.3 “Developing 
in C#” for each development environment. 
 
For the list of the libraries provided by the IT-9000 BDK, refer to Chapter 1.2 “Library 
Configuration”. For detail about each function of the Common Device Control Library and Common 
Device Control Class Library, refer to Common Device Control Library Manual. 
 
The example program in this chapter runs also in the Device Emulator. To use the emulator, rename 
IT-9000 Device to IT-9000 Emulator. 
 
Notes: 

 Functions of the Common Device Control Library which control various individual devices 
integrated in IT-9000 have different name spaces and names from those available for the 
previous CASIO handheld terminals. They are not compatible with the ones in the previous 
CASIO library. The exceptions are DT-X7, DT-X11, and IT-600 that use the same libraries. 

 Applications developed with any functions of CASIO dedicated library must be rewritten by 
replacing the dedicated functions with the appropriate functions from the Common Device 
Control Library. 

 Take care when using Visual Studio 2008 or Visual Studio 2005 to upgrade an existing 
application and always keep a backup of your existing project. 
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8.1 Developing in C++ 

This chapter describes necessary steps to develop the example application program (see Chapter 8) 
in C++ environment using the Common Device Control Library. 
Before proceeding to creating the project, check if the installation folder for the Common Device 
Control Library has been registered in Visual Studio 2008 or Visual Studio 2005 by following steps, 
1 to 8, below. 
 
1. Navigate to Tools → Options … and open Options screen. 
2. Navigate to Projects and Solutions → Directories. 
3. Choose IT-9000 (ARMV4I) in Platforms. 
4. Choose Include files in Show directories for:. 
5. If the installation folder has not been registered, append the following. 

C:\Program Files\CASIO\MBSYS\include 
6. Choose Library files in Show directories for:. 
7. If the files have not been registered, append the following. 

C:\Program Files\CASIO\MBSYS\lib\ARMV4I 
8. Click OK button to close the screen. 
 

Application Development Procedure 

Subsequent steps show how to create and start up a simple program using one of the system 
functions. When running the program, the LED will blink in red for 5 seconds. 
 
1. First, create Win32 Smart Device Project with its device name DeviceApp for Visual C++ 

in Visual Studio 2008 or Visual Studio 2005. 
2. Choose Pocket PC 2003 in the Selected BDKs field in the Platforms of Win32 Smart Device 

Project Wizard and click < button. 

 
Figure 8.1 
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3. Choose IT-9000 in the Installed BDKs (SDKs in the screen) field and click > button. 

 
Figure 8.2 

 
4. Click Next > button while IT-9000 is kept being highlighted in the Selected BDKs (SDKs in 

the screen) field. 

 
Figure 8.3 
 
5. Choose Console Application for the Application type in the Application Settings menu, and click 

Finish button. 
6. In Solution Explorer, click DeviceApp.cpp and then append the source code below subsequent 

to “#include <commctrl.h>”. 
 

#include <SystemLib.h> 

#if !defined(_countof) 

#define _countof(_Array) (sizeof(_Array) / sizeof(_Array[0])) 

#endif 
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7. Append the source code below in the main function of DeviceApp.cpp. 

    DWORD result; 

    TCHAR msg[16]; 

 

    result = SysSetLED(LED_RED, 5, 8, 8); 

 

    if(result == TRUE) 

    { 

        result = SysGetLED(); 

        switch(result & 0x0000000F) { 

        case LED_OFF: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_OFF") ); 

            break; 

        case LED_RED: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_RED") ); 

            break; 

        case LED_GREEN: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_GREEN") ); 

            break; 

        case LED_ORANGE: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_ORANGE") ); 

            break; 

        case LED_BLUE: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_BLUE") ); 

            break; 

        case LED_CYAN: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_CYAN") ); 

            break; 

        case LED_MAGENTA: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_MAGENTA") ); 

            break; 

        default: 

            wcscpy_s( msg, _countof(msg), TEXT("LED_UNKNOWN") ); 

            break; 

        } 

        MessageBox(NULL, msg, TEXT("LED"), MB_OK); 

    } 
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8. Choose Properties in the Project of Visual Studio 2008 or Visual Studio 2005, and navigate to 

Configuration Properties  Linker  Input  Additional Dependencies and then 
append SystemLib.lib (see red circle in Figure 8.4). 

 
Figure 8.4 
 
9. Choose IT-9000 Device for the Target Device to establish connection with the PC. 

10. Choose Debug in Visual Studio 2008 or Visual Studio 2005 and then click either Start Debugging 
or Start Without Debugging. 

11. The source code will be compiled and the application will be copied to the \Program 
Files\<name of project> in the IT-9000 folder.The project will be built and copied to the 
“\Program Files\<name of project>” folder by default in IT-9000.  

12. Check that the program runs correctly on the IT-9000. 
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8.2 Developing in VB.NET 

This chapter describes necessary steps to develop the example application program (see Chapter 8) 
in VB.NET environment using the Common Device Control Class Library. 
 

Application Development Procedure 

Subsequent steps show how to create and start up a simple program using one of the system 
functions. When running the program, the LED will blink in red for 5 seconds. 
 
1. Create a new VB.NET Smart Device Application in Visual Studio. 
2. In Solution Explorer, right-click References and click Add Reference… 
3. Click Browse and navigate to the folder where you have stored the CASIO .NET library files. 

Highlight SystemLibNet.dll and click it to open. Click OK button. 

 
Figure 8.5 
 

4. Add a button to the form, rename it LED, and double click it. 
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5. In the event function for the button to click, add the following code. 

Dim result As Int32 

Dim msg As String 

 

result = Calib.SystemLibNet.Api.SysSetLED( _ 

            Calib.SystemLibNet.Def.LED_RED, 5, 8, 8) 

 

'.NET vales of “true” and “false” are “-1” and “0” respectively. 

If result = -1 Then 

    result = Calib.SystemLibNet.Api.SysGetLED() 

    Select Case (result And &HF) 

        Case Calib.SystemLibNet.Def.LED_OFF 

            msg = "LED_OFF" 

        Case Calib.SystemLibNet.Def.LED_RED 

            msg = "LED_RED" 

        Case Calib.SystemLibNet.Def.LED_GREEN 

            msg = "LED_GREEN" 

        Case Calib.SystemLibNet.Def.LED_ORANGE 

            msg = "LED_ORANGE" 

        Case Calib.SystemLibNet.Def.LED_BLUE 

            msg = "LED_BLUE" 

        Case Calib.SystemLibNet.Def.LED_CYAN 

            msg = "LED_CYAN" 

        Case Calib.SystemLibNet.Def.LED_MAGENTA 

            msg = "LED_MAGENTA" 

        Case Else 

            msg = "LED_UNKNOWN" 

    End Select 

    MessageBox.Show(msg, "LED") 

End If 

 
Note:  
If you type this code manually you should see the IntelliSense offer you suitable options as 
appropriate. If you do not, make sure you review steps 1 to 5 to make sure you have added the 
reference correctly. 

 
6. Initiate ActiveSync to establish connection between IT-9000 and PC. 
7. Choose Deploy <name of project> on Build menu. 
8. The source code will be compiled and the application will be copied to the \Program 

Files\<name of project> in the IT-9000 folder. SystemLibNet.dll will be deployed to the 
same folder. 

9. Check that the program works correctly on IT-9000. 
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8.3 Developing in C# 

This chapter describes necessary steps to develop the example application program (see Chapter 8) 
in C# environment using the Common Device Control Class Library. 
 

Application Development Procedure 

Subsequent steps show how to create and start up a simple program using one of the system 
functions. When running the program, the LED will blink in red for 5 seconds. 
 
1. Create a new C# Smart Device Application in Visual Studio .NET. 
2. In Solution Explorer, right click References and click Add Reference… 
3. Click Browse and navigate to the folder where you have stored the CASIO .NET library files. 

Highlight SystemLibNet.dll and click Open. Click OK button. 

 

Figure 8.6 
 

4. At the top of your source file add the following code.  

using Calib; 
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5. Add a button to your form, rename it LED and double click it and then add the following code: 

Int32 result = new Int32(); 

string msg; 

 

result = SystemLibNet.Api.SysSetLED(SystemLibNet.Def.LED_RED, 5, 

8, 8); 

 

// .Net values “true” and “false” are “-1” and “0” respectively. 

if(result == -1) 

{ 

    result = SystemLibNet.Api.SysGetLED(); 

    switch(result & 0x0000000F)  

    { 

        case SystemLibNet.Def.LED_OFF: 

            msg = "LED_OFF"; 

            break; 

        case SystemLibNet.Def.LED_RED: 

            msg = "LED_RED"; 

            break; 

        case SystemLibNet.Def.LED_GREEN: 

            msg = "LED_GREEN"; 

            break; 

        case SystemLibNet.Def.LED_ORANGE: 

            msg = "LED_ORANGE"; 

            break; 

        case SystemLibNet.Def.LED_BLUE: 

            msg = "LED_BLUE"; 

            break; 

        case SystemLibNet.Def.LED_CYAN: 

            msg = "LED_CYAN"; 

            break; 

        case SystemLibNet.Def.LED_MAGENTA: 

            msg = "LED_MAGENTA"; 

            break; 

        default: 

            msg = "LED_UNKNOWN"; 

            break; 

    } 

    MessageBox.Show( msg, "LED"); 

} 

 

Note: 
If you add this code manually you should see the IntelliSense offer you suitable options as 
appropriate. If you do not see this, then review steps 2 to 4 in the previous page to make sure you 
have not made a mistake. 
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6. Initiate ActiveSync to establish connection between IT-9000 and PC. 
7. Select Deploy <name of project> on Build menu. 
8. The source code will be compiled and the application will be copied to IT-9000. By default, it 

will be copied to \Program Files\<name of project> folder. SystemLibNet.dll will be deployed 
to the same folder. 

9. Check that the program works correctly on the device. 
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9. Differences 

Content IT-9000/IT-9000-B series IT-9000-C series Remark 

TURBO 624MHz 806MHz   

NORMAL 312MHz 624MHz   

POWERSAVE 208MHz 208MHz   
CPU 

AUTO 104, 208, 312, 624 MHz 104, 208, 624, 806 MHz   

Capacity 256MB 512MB   
RAM 

User Area 160MB 340MB   

Capacity 256MB 512MB   

RootDisk 90MB 120MB   FROM 

FlashDisk 90MB 224MB   

Symbology (1D) Code11/IATA: Support Code11/IATA: Unsupport   

Symbology (2D) Code49/TLC39: Support Code49/TLC39: Unsupport   

Image Capture 
nRight (maximum)   : 752 
ｎBottom (maximum) : 480 

nRight (maximum)   : 832 
ｎBottom (maximum) : 640 

  

Code39: Support Code39: Support   

Codabar (NW-7) : Support Codabar (NW-7) : Unsupport   

Code128: Support Code128: Unsupport   

PDF417: Support PDF417: Support   

Sign Capture 

Aztec Code: Support Aztec Code: Support   

Preview 
nRight (maximum)   : 752 
ｎBottom (maximum) : 480 

nRight (maximum)   : 832 
ｎBottom (maximum) : 640 

  

APO Default : Disable Default : 60s (Enable) 

To start scanning from imager 
APO, it takes about 100 
miliseconds to power up imager 
and exposure adjustment. 

Decode Window 
Size 

nRight (maximum)   : 752 
ｎBottom (maximum) : 480 

nRight (maximum)   : 832 
ｎBottom (maximum) : 640 

  

Imager 

How to Use the 
Decode Window 

Not including the center of the 
capture size 

Including the center (416, 320) 
of the capture size 

  

Printer Low Temperature 
Use a battery of ordinary 
temperature 

Use a battery of low 
temperature 

Depending on registry 

Version Ver2.0+EDR Ver2.1+EDR   

GAP GAP   

SDP SDP   

Serial Profile Serial Profile   

Bluetooth 
Profile 

DUN DUN  

802.11 Standard 802.11 b/g 802.11 b/g/n   

Device Name SDIO86861 TIWLNAPI1   WLAN 

Multi SSID Unsupport Support   
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Imager 
Setting 

Readable 
Symbologies 

Code11 / IATA / Code49 / 
TLC39 : Support 

Code11 / IATA / Code49 / 
TLC39 : Unsupport 

  

WLAN 
Settings 

Multi SSID Unsupport Support   

LAN Cradle   Unsupport Support   
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10. Resources 

Microsoft’s own http://msdn.microsoft.com/mobility/ is an extremely comprehensive resource for 
programmers targeting WindowsCE .NET based devices. It includes links to most other useful web 
based resources. You will find detailed Software and Library manuals on 
http://world.casio.com/system/pa. 

http://msdn.microsoft.com/mobility/�
http://world.casio.com/system/pa�

	Editorial Record
	Preface
	1. Product Overview
	1.1 Features at a Glance
	1.2 Library Configuration
	1.3 Development Manuals

	2. Prerequisites
	2.1 Skills Required
	2.2 Hardware Required
	2.3 Software Required

	3. Installing BDK to PC
	3.1 Application Development
	3.2 Installing CASIO BDK Files
	3.3  Installing Library
	3.4 Installing Online Help

	4. Connecting Power Supply to Cradle
	4.1 HA-L60IO
	4.2 HA-L62IO

	5. Connecting IT-9000 to PC
	5.1 ActiveSync Connection via USB
	5.1.1 Installing ActiveSync for the First Time
	5.1.2 If ActiveSync Is Already Installed

	5.2 Windows Mobile Device Center via USB
	5.3 Connection via WLAN
	5.4 Connection via Ethernet Cradle
	5.5 Accessing Shared Network Drive on Your LAN
	5.6 Direct TCP/IP Connection from Visual Studio

	6. Setting Up the Development Environment
	6.1 Installing CAB Files
	6.2 Visual Studio 2005

	7. Device Emulator
	7.1 Software Required
	7.2 Starting Up the Device Emulator
	7.3 Using the Device Emulator
	7.3.1 IT-9000 Device Emulator
	7.3.2 I/O Simulator
	7.3.3 Connecting via ActiveSync

	7.4 Debugging Applications

	8. Visual Studio
	8.1 Developing in C++
	8.2 Developing in VB.NET
	8.3 Developing in C#

	9. Differences
	10. Resources

